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[bookmark: _Toc305688217]Glossary and Abbreviations
	BOM
	Australian Bureau of Meteorology

	E
	External Floating Roof Tank

	H
	Horizontal Fixed Roof Tank

	HAP
	Hazardous air pollutant

	NPI
	National Pollution Inventory

	OAQPS
	United States Office of Air Quality Planning and Standards

	R
	Internal Floating Roof Tank

	RVP
	Reid Vapour Pressure

	U
	Underground Horizontal Tank

	US EPA
	United States Environmental Protection Agency

	V
	Vertical Fixed Roof Tank

	VOC
	Volatile Organic Compound
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[bookmark: _Toc305688218]About Tanks
TANKS 4.09d is a Windows-based computer software program that estimates volatile organic compound (VOC) and hazardous air pollutant (HAP) emissions from horizontal and vertical, fixed- and floating-roof storage tanks. The United States Environmental Protection Agency’s (US EPA) Office of Air Quality Planning and Standards (OAQPS) develops and maintains emissions estimating tools to support Federal, State, and local agencies, consultants, and industry with estimating air emissions from various sources.
TANKS 4.09d allows users to enter specific information about a storage tank (dimensions, construction, paint condition, etc.), the liquid contents (chemical components and liquid temperature), and the location of the tank (nearest city, ambient temperature, etc.), and generate an air emissions report. Report features include estimates of monthly, annual, or partial year emissions for each chemical or mixture of chemicals stored in the tank. For National Pollutant Inventory (NPI) purposes only annual reports are required. 
[bookmark: _Toc305688219]Where and How to Download
At the time of this report, TANKS 4.09D is available to download from the US EPA website. 
http://www.epa.gov/ttnchie1/software/tanks/ 
The software is provided free of charge along with a comprehensive user manual US EPA User Guide to Tanks that should be used in conjunction with this manual as a technical guide.
Installation
To setup TANKS 4.09d on a personal computer, double-click on the downloaded file. The installation utility will guide the user through the setup process. Once the program is installed on the computer, it may be started by opening the file in the destination folder.
Downloading Australian Databases
As TANKS 4.09d is designed for use in the US, the databases provided with the software are not applicable for Australian users. Therefore alternative databases have been provided by NPI and provide information relevant to the Australian climate including meteorological data for major cities and regions, such as:
· Average, maximum and minimum temperature, 
· Average wind speed,
· Annual average solar insulation factor; and,
· Atmospheric pressure  
These databases are available to download from the NPI website
http://www.npi.gov.au/publications/emission-estimation-technique/fols.html 


In addition to downloading TANKS 4.09d, it is necessary to download:
· The NPI TANKS Database: The “Tank Database” contains the chemical, meteorological, fitting, rim seal, deck seam, and profile information for the Australian context.
· The NPI Client Database: The “Client Database” stores the information used during data entry for each tank record. The data will be copied to the file location selected. This database is not required, however it does provide examples of default tanks at different locations around Australia

[bookmark: _Toc305688220]Accessing and Saving Databases
Once the NPI Tank database and client database (as required) have been downloaded it is necessary to ‘restore’ the databases in the TANKS 4.09d. To do this, follow the steps below:
[bookmark: _Toc305688221]To restore the Tank Database
1. Open TANKS 4.09d 
2. Click on the ‘Backup’ drop down menu -> Restore Tank Database From Backup
3. Select the ‘NPI TANKS Database’ file that you previously downloaded from the NPI website and press open
4. If this has been done correctly the message in Figure 1 will be displayed. 
[bookmark: _Toc305688243]Figure 1	Confirmation message for correctly restoring databases
[image: ]

[bookmark: _Toc305688222]To restore the Client Database
1. Click on the ‘Backup’ drop down menu -> Restore Client Database from Backup
2. Select the ‘NPI Client Database’ file that you previously downloaded from the NPI website and press open.
3. Again, if this was done correctly you should receive a message similar to Figure 1
[bookmark: _Toc305688223]To save/backup the Client and Tank Database
1. Click on the ‘Backup’ drop down menu -> Backup Client or Tank Database 


[bookmark: _Toc231628800][bookmark: _Toc305688224]Site Information Required Prior to Use
Prior to using TANKS 4.09d to estimate emissions, you will need to gather the following information about the type of tank, geographical location and substances stored in the tank.
[bookmark: _Toc305688225]Tank Information
TANKS 4.09d is designed to calculate the estimates VOC and HAP emissions from the following types of tanks:
· External floating roof tank
· Horizontal tank
· Internal floating roof tank
· Underground horizontal tank
· Vertical fixed roof tank
The matrix below shows the information required for each tank type regarding the size and condition of tank is required prior to using TANKS 4.09d to estimate emissions:
[bookmark: _Toc305688245]Table 1	Essential tank information required for use of TANKS 4.09d
	
	External floating roof tank
	Horizontal Tank
	Internal floating roof tank
	Underground horizontal tank
	Vertical fixed roof tank

	Shell length
	
	
	
	
	

	Tank diameter
	
	
	
	
	

	Tank volume
	
	
	
	
	

	Turnovers per year
	
	
	
	
	


Note that TANKS requires inputs in imperial units.  See Section 5 for further details.
The table below lists the default values that should be used in TANKS if no information is available. While these variables do affect the outcome of the report the extent is marginal when compared to the parameters above. 
[bookmark: _Toc305688246]Table 2	Default variables for input into TANKS 4.09d
	
	External floating roof tank
	Horizontal Tank
	Internal floating roof tank
	Underground horizontal tank
	Vertical fixed roof tank

	Internal Shell Condition
	Gunite Lining
	N/A
	Gunite Lining
	N/A
	N/A

	External Shell Colour/Shade
	White/White
	White/White
	White/White
	White/White
	White/White

	External Shell Condition
	Good
	Good
	Good
	Good
	Good

	Roof Colour/Shade
	N/A
	N/A
	White/White
	N/A
	White/White

	Roof Paint Conditions
	N/A
	N/A
	Good
	N/A
	Good

	Roof Type
	Pontoon
	N/A
	N/A
	N/A
	Cone

	Roof Fitting Category
	Typical
	N/A
	N/A
	N/A
	N/A

	Is tank heated
	No
	No
	No
	No
	No

	Vacuum Vent Setting
	N/A
	-0.03
	N/A
	-0.03
	-0.3

	Pressure Vent Setting
	N/A
	0.03
	N/A
	0.03
	0.3

	Primary Seal
	Liquid Mounted
	N/A
	Liquid Mounted
	N/A
	N/A

	Secondary Seal
	Rim mounted
	N/A
	None
	N/A
	N/A

	Deck Type
	Welded
	N/A
	Welded
	N/A
	N/A

	Deck Fitting Category
	N/A
	N/A
	Typical
	N/A
	N/A



[bookmark: _Toc305688226]Location Information
As discussed in Section 3, NPI has provided a database that lists the meteorological information for many major cities and regions around Australia. 
In addition, for users who are not located in the close vicinity of a major city, the average meteorological data has been compiled for specific major climatic zones in Australia (Table 3 and Figure 2).
[bookmark: _Toc305688247]Table 3	Default regions and their corresponding geographical locations
	Name
	Location

	Region 01
	South Australia South

	Region 02
	Western Australia South

	Region 03
	Western Australia Central

	Region 04
	Australia North

	Region 05
	Australia Central

	Region 06
	Queensland Far North East

	Region 07
	Queensland Central North

	Region 08
	Queensland Central

	Region 09
	Queensland South

	Region 10
	New South Wales

	Region 11
	Victoria

	Region 12
	Tasmania


[bookmark: _Toc304876532]
[bookmark: _Toc305688244]
Figure 2	  Map of Australia showing breakup of default regions
[image: ]
Alternatively, it is possible to enter the meteorological information for the specific location of the tank. In some cases it is possible to obtain this data from Australian Bureau of Meteorology (BOM). If this approach is to be taken, the following information will be required.
· Daily Average Ambient Temperature (F)
· Annual Average Maximum Temperature (F)
· Annual Average Minimum Temperature (F)
· Average Wind Speed (mph)
· Annual Average Solar Insulation Factor (Btu/(ft’ft’day))
· Atmospheric Pressure (psia)
Figure 3	  Meteorological data input screen
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic1.jpg]
[bookmark: _Toc305688227]Substance Information
Finally, the liquid content of the tank is required. As with the meteorological data, information on the vast majority of fuels and organic liquids have been added to the databases and it will simply be a case of selecting the appropriate liquid from the dropdown. However, please note that if this is not the case, it may be necessary to manually enter information regarding the chemical into tanks. In this situation, please see Section 4.5 of the US EPA User Guide to Tanks.


[bookmark: _Toc231628807][bookmark: _Ref305581809][bookmark: _Toc305688228]Conversion From Metric to Imperial
As TANKS 4.09d was originally designed for use in the US it is necessary to convert all measurements from metric to imperial prior to entering details of the tank and substance into the program. 
It is expected that for the majority of cases, the only measurements that will need to be converted are:
· Length, height, width – from meters (m) to feet (ft)
· Volume – from litres (L) to US gallon (Gal)
· Temperature – from Celsius to Fahrenheit
· Pressure - hPa to psi
The table below provides conversion rates for all the units required in TANKS 4.09d.
[bookmark: _Toc305688248]Table 4	Metric / imperial conversions 
	To convert from
	To convert to
	Multiply by

	Mass

	Kilogram (kg)
	Pound (lb)
	2.204

	Pound (lb)
	Kilogram (kg)
	0.454

	Volume

	US Gallons (gal)
	Litres (L)
	3.785

	Litres (L)
	US Gallons (gal)
	0.2642

	Length

	Metres (m)
	Foot (ft)
	3.280

	Foot (ft)
	Metres (m)
	0.304

	Temperature

	Celsius (°C)
	Fahrenheit (°F)
	9/5 × °C + 32

	Fahrenheit (°F)
	Celsius (°C)
	(°F – 32) × 5/9

	Pressure

	lb per square inch (psi)
	Hectopascal (hPa)
	69

	Hectopascal (hPa)
	lb per square inch (psi)
	0.01450

	Millibar
	Hectopascal (hPa)
	1

	Note:
1. The unit psi is either psig (pound per square inch gauge) or psia (pounds per square inch absolute). Gauge is in reference to 1 atmosphere pressure (14.7 psia or 1013 hPa)
2. Note US gallons are not the same UK gallons.In relation to any work involving TANKS the unit gallon or gal refers to the US gallons.


[bookmark: _Toc231628814]


[bookmark: _Toc305688229]Entering Data
TANKS 4.09d requires specific information about a storage tank (dimensions, construction, paint condition, etc.), the liquid contents (chemical components and liquid temperature), and the location of the tank (nearest city, ambient temperature, etc.) to generate an air emissions report. This information is entered into and stored in a tank record.
Users have the option of creating an entirely new tank record or, alternately, they can edit default tank records that the NPI has developed. 
[bookmark: _Toc305688230]Using default tank records
To open a default tank record select Data -> Tanks -> Edit Record -> Choose the appropriate record from the drop down list -> Edit 
[bookmark: _Toc305688231]Creating a new tank record 
To create a new tank record select Data -> Tanks -> New record -> Select the appropriate tank type
[bookmark: _Toc305688232]Tank Records
Tank records contain all the parameters for a specific tank such as its size, location, contents and condition. These details must be correctly entered prior to running an emission report.
[bookmark: _Toc305604618]Identification  
Information contained within the Identification section is user-defined and is designed to provide a reference for users with multiple tank types. Each tank can be identified by five data fields: identification number, description, city, state and company. Information entered into this section of the Tank record does not affect the emission report.
Figure 4	  Identification tab
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic2.jpg]

[bookmark: _Toc305604619]Physical Characteristics 
The physical characteristics required by TANKS 4.09d to produce an emission report varies depending on the type of tank.  The default entries should be left if the actual value/answer is unknown.
Figure 5	  Physical Characteristics tab
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic3.jpg]
The table below details the required physical characteristics for each tank type. 
[bookmark: _Toc305688249]Table 5	Data requirements for tank types
	External floating roof tank
	Horizontal Tank
	Internal floating roof tank
	Underground horizontal tank
	Vertical fixed roof tank

	Diameter (ft)
	Shell Length (ft)
	Diameter (ft)
	Shell Length (ft)
	Shell Height (ft)

	Tank Volume (gal)
	Shell Diameter (ft)
	Tank Volume (gal)
	Shell Diameter (ft)
	Shell Diameter (ft)

	Turnovers per year 
	Working Volume (gal)
	Turnover per year
	Working Volume (gal)
	Maximum Liquid Height (ft)

	Net Throughput (gal/yr)
	Turnovers per Year
	Net Throughput (gal/yr)
	Turnovers per Year
	Average Liquid Height (ft)

	Internal Shell Condition
	Net Throughput (gal/yr)
	Self-Supporting Roof?
	Net Throughput (gal/yr)
	Working Volume (gal)

	Paint Colour/Shade
	Is Tank Heated?
	Number of Columns
	Is Tank Heated?
	Turnovers per Year

	Paint Condition
	Is the Tank Underground
	Effective Column diameter
	Is the Tank Underground
	Net Throughput (gal/yr)

	Roof Type
	Shell Colour/Shade
	Internal Shell Condition
	Vacuum Settings (psig)
	Is Tank Heated?

	Roof Fitting Category
	Shell Condition
	External Shell Colour/Shade
	Pressure Settings (psig)
	Shell Colour/Shade

	Tank Construction
	Vacuum Setting (psig)
	External Shell Condition
	
	Shell Condition

	Primary Seal
	Pressure Setting (psig)
	Roof Colour/Shade
	
	Roof Colour/Shade

	Secondary Seal
	
	Roof Paint Condition
	
	Roof Condition

	
	
	Primary Seal
	
	Roof Type

	
	
	Secondary Seal
	
	Roof Height

	
	
	Deck Type
	
	Roof Slope (ft/ft) (Cone)

	
	
	Deck Fitting Category
	
	Vacuum Setting (psig)

	
	
	
	
	Pressure Setting (psig)



For further information and descriptions of each requirement please see Section 4.2 of the US EPA User Guide to Tanks.
[bookmark: _Toc305604620]Site Selection
The Site Selection screen is identical in all five tank types. As discussed in Section 3 and 5.2, the NPI database provided contains meteorological information for the major cities of Australia and also average data for 12 regions of Australia such as temperatures, wind speed, and solar insolation factors. If the user wishes to use one of the predetermined locations, it is simply a case of selecting the relevant one from the dropdown list. 
Figure 6	  Site Selection tab
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic4.jpg]
Alternatively, if more accurate or relevant information is available (such as BOM data), it is possible for users to create or edit a meteorological record. For more information on creating and editing meteorological data please see Section 6.2 of the US EPA User Guide to Tanks. 






[bookmark: _Toc305604621]Tank Contents
The fields shown on this screen vary according to the type of tank, whether the tank is heated, and the liquid contents. 
Figure 7	  Tank Contents tab
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic5.jpg]
Chemical Category of Liquid
There are three chemical categories
· Petroleum Distillates – Unleaded petrol, diesel, jet fuels, AV gas etc.
· Crude oils – unrefined petroleum stocks
· Organic Liquids – All organic compounds and mixtures 
Single – or Multi-Component Liquid
This field indicates whether the liquid stored in the tank consists of a single component or a mixture of components. 
Petroleum distillates and crude oils may be entered as single-component liquids if the emissions estimates for individual chemicals are not needed.  If a breakdown of emissions by underlying components is needed enter the liquid data as a Multi-Component Liquid.  Note a breakdown is required if the mixture contains any NPI-listed chemicals (e.g., benzene emissions from storing petroleum).
Speciation Options
When a Multi-Component liquid is selected the Speciation Option field is displayed which gives 4 options to choose from as follows:
Full Speciation: This option can be used if you know the names of each substance in the mixture and their concentrations.  The details of each substance can be added using the ‘Add/View Components’ option.  The program will calculate the vapour pressure and other data for the entire mixture.  
Partial Speciation: The TANKS program provides generic speciation profiles for fuels which can be used with the partial speciation option only to calculate emissions.  The relevant fuel type or mixture should be selected from the mixture name option (e.g. Distillate fuel oil no 2).  Then the ‘Copy Speciation Profile’ button can be used to access a drop down menu where the generic fuel data can be selected and added (e.g. diesel).  The percent of total liquid weight if known can be adjusted by using the ‘View/Add Components’ option.   Substance data can also be added or removed if required in this Specify Components screen.  
Vapour Weight Speciation: This option is similar to the partial speciation option but requires that the percentage of the total vapour weight is added for all individual substances.   
None: This option allows you to add specific chemical data for the mixture but will not give emissions for individual components/substances. 
For more information on single and multiple speciations please see Section 4.5 of the US EPA User Guide to Tanks


[bookmark: _Toc305604624]Monthly Calculations
The final tab of the Tank Record provides an option for calculating the emissions for particular months of the year. For the purpose of NPI reporting, annual emission data is required so it is important to make sure all months are selected. 
Figure 8	  Map of Australia showing breakup of default regions
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic6.jpg]
[bookmark: _Toc231628821][bookmark: _Toc305688233]Default Tank Types and Parameters
As mentioned in Section 5.1, TANKS 4.09d is designed to measure the emissions from five different types of tanks:
· External Floating Roof Tank (E)
· Horizontal Fixed Roof Tanks (H)
· Internal Floating Roof Tank (R)
· Underground Horizontal Tank (U)
· Vertical Fixed Roof Tanks (V)
The Australian tanks database has a number of default tanks programmed into it. The default tank type entries can be used as a basis for entering site-specific tank data, but it is recommended that users should avoid using these measurements unless no information on tank size is available. Tank size plays a significant role in determining the extent of emissions and therefore using incorrect measurements has the potential to under or overestimate emissions.
[bookmark: _Toc305688234]External floating roof tank
This type of tank consists of a cylindrical steel shell equipped with a roof that floats on the surface of the stored liquid.
[bookmark: _Toc305688250]

Table 6	Default parameters for external floating roof tanks
	Tank ID
	Description
	Diameter
	Height
	Volume

	
	
	(m)
	(ft)
	(m)
	(ft)
	(m³)
	(gal)

	E01
	External Floating Roof Tank
	33.53
	110
	7.67
	25
	6,770
	1.79M



[bookmark: _Toc305688235]Horizontal fixed roof tanks
These tanks are constructed above-ground with the axis parallel to the foundation. Horizontal fixed roof shells may be steel, steel with a fiberglass overlay, or fiberglass-reinforced polyester. These tanks may be specified as “heated” in TANKS 4.0
[bookmark: _Toc305688251]Table 7	Default parameters for horizontal fixed roof tanks
	Tank ID
	Description
	Diameter
	Length
	Volume

	
	
	(m)
	(ft)
	(m)
	(ft)
	(m³)
	(gal)

	H01
	Horizontal Fixed Roof Tank
	3.0
	9.8
	14.85
	48.7
	100
	26,417





[bookmark: _Toc305688236]Internal floating roof tanks
This type of tank has both a permanent fixed roof and a floating deck.
[bookmark: _Toc305688252]Table 8	Default parameters for internal floating roof tanks
	Tank ID
	Description
	Diameter
	Height
	Volume

	
	
	(m)
	(ft)
	(m)
	(ft)
	(m³)
	(gal)

	R01
	Internal Floating Roof Tank
	26.55
	87
	15.3
	50
	8,470
	2.24M



[bookmark: _Toc305688237]Underground horizontal tank
These tanks are underground with the axis parallel to the foundation. Horizontal fixed roof shells may be steel, steel with a fiberglass overlay, or fiberglass-reinforced polyester. These tanks may be specified as “heated” in TANKS 4.0
[bookmark: _Toc305688253]Table 9	Default parameters for underground horizontal tanks
	Tank ID
	Description
	Diameter
	Length
	Volume

	
	
	(m)
	(ft)
	(m)
	(ft)
	(m³)
	(gal)

	U01
	Underground Horizontal Tank
	3.0
	9.8
	14.85
	48.7
	100
	26,417


[bookmark: _Toc305688238]Vertical fixed roof tanks
These tanks consist of cylindrical shells with permanently affixed roofs; the tank axis is perpendicular to the foundation. The fixed roof may be dome-shaped or cone shaped. Vertical fixed roof tank shells are usually constructed of steel. These tanks may be specified as “heated” in TANKS 4.0
[bookmark: _Toc305688254]Table 10	Default parameters for vertical fixed roof tanks
	Tank ID
	Description
	Diameter
	Height
	Volume

	
	
	(m)
	(ft)
	(m)
	(ft)
	(m³)
	(gal)

	V01
	Vertical Fixed Roof Tank
	26.55
	87
	15.55
	51
	8,470
	2.24M


[bookmark: _Toc305688239]Generating Reports
TANKS 4.09d is designed so reports can be tailored to provide as little or as much information as required. For the purpose of NPI reporting, it is recommended that the Brief Report option be used. This report provides emission totals for the fuel stored in the tanks as well as a breakdown of the emissions of the related compounds. 

[bookmark: _Toc305688255]Table 11	Example of a brief emissions report for an external floating roof tank
[image: ]
There are two ways to generate an emissions report using TANKS 4.0. You may use the Report menu on the main menu or you may run an emissions report while viewing a tank record. The advantage of using the Report option from the main menu is that you may generate reports for more than one tank at a time. The advantage of running reports from within the Tank Records data entry/edit screens is that you may immediately correct errors in the data.
[bookmark: _Toc305688240]Generating a report using the Report menu
This option is advantageous as it allows you to run a report for multiple tanks. However, prior to running a report using the report menu, the user must have previously entered the specific information for the tank e.g. location, substance etc. For instructions on how to do this, see Section 7 of this manual.
Figure 9	  Report selection screen from report menu
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic7.jpg]
1. Choose Report menu -> Annual ->Brief
2. Select the tank(s) for which you wish to generate a report and press ‘Run Report’
3. Chose File -> Ok -> Windows/Printer -> Ok.
Note: for ease of use it is recommended that users chose to view data in Windows/Printer. However, it is also possible to save the report as an excel file.

[bookmark: _Toc305688241]Generating a report while viewing a tank record
This option allows the user to run a report directly from the tank record and is useful as it allows users to conduct a final check that all the data entered in the tank record is accurate prior to running the report.
Figure 10  Report selection screen from tank record
[image: \\nwafp01vp\usersprofiles$\oliver.edgson\My Documents\KMH\FOLS\Screen shots\pic8.jpg]
1. Chose ‘Run Report’ from the Tank Record.
2. For report type select ‘Brief’
3. For the time basis select ‘Annual’
4. Chose File -> Ok -> Windows/Printer -> Ok.
Note: for ease of use it is recommended that users chose to view data in Windows/Printer. However, it is also possible to save the report as an excel file.
[bookmark: _Toc305688242]

Conversion from Imperial to Metric for NPI Reporting.
For NPI reporting purposes, it is necessary to convert the emission totals produced in the report from pounds (lb) to kilograms (kg). 

 (
E 
(lb) 
× 
  2.204
=
  
 E 
(kg)
)



E (lb) = Emission total in pounds (lb)
E (kg) = Emission total in kilograms (kg)
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